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Introduction

This software started as a program to display ThunderScan™ SCAN files in true gray scales on a Mac Il. |
completed that phase of the program in August of 1987 and freely distributed early versions on bulletin boards and via
user groups. The latest public version of that software was 1.16. It did nothing more than display and save PICT files,
and allowed you to save pictures as StartupScreens.

In September of 1987 | decided that | wanted my program to do real things so | set to the task of adding various
MacPaint-like features and trying to understand what it was that people would want to do with gray scale and color
pictures. | had never written real MacPrograms before, and | have no experience or training in graphics programming. |
started discussions with people about commercial distribution; that was very encouraging and | fully intended to sell the
final version. ImageStudio started to become known at this point, obvious competition. | worked intensely on GrayView
for two months. | worked hard to make it commercial quality, with pleasant dialog boxes, low memory warnings, etc.

But I'm a graduate student in mathematics and the program was taking a lot of time from my studies. | finally
decided in December to halt work on GrayView, cancel discussions with distributors, and move on. | wasn't sure if I'd

ever want to sell the program later so | never released it wide spread, like the earlier versions.



I had given copies to several people and they seemed to like it. By now it seems that GrayView has no
commercial future, so I'm releasing this unfinished version for general use and playing. It's fun to goof around with and
it has many PixelPaint and ImageStudio features. It has lots of missing features, though, things | never got around to
completing before | quit programming. In particular, the dragging and pasting functions aren't quite what they should be.

| don't expect to improve the program any beyond this point. If you want to contact me with suggestions or
guestions, | can try to help within reason, and I'm always happy to get mail, but | think this is pretty much the end of the
road for GrayView. Nevertheless, | reserve all rights to the software. It may not be distributed commercially in anyway
without my consent, or included with any commercial product.

This documentation describes the features, but in an admittedly sloppy fashion. | wrote it while programming to
send to testers and haven't had time to fix it up since then. It talks about some things in the future tense (e.g., "the
program doesn't yet..."). Everything is actually in there, just hard to read. You get what you pay for.

I will point out one special feature, though. In the dialog box from the Preferences menu item (under Edit), you
can turn "native colors" on and off. The native colors option makes GrayView display color images with the exact color
table used to create the image, regardless of what program originally made it. However, opening another picture later
will screw up the colors in the window. Many of the program's other features will do the same. Native colors are nice
for looking at images and light touch up, but many of the tools work better with native colors turned off. If you are
having trouble, turn off the native colors, and re-open the picture.

I hope you have fun with GrayView.

David Fry



GrayView is especially designed to convert ThunderScan™ SCAN documents to gray scale images on a Mac Il
This version allows the user to manipulate the picture in several fundamental ways, sort of like a MacPaint for gray
scales. Also, GrayView can be used to view and manipulate any PICT image, color or B/W.

GrayView should be used in 16 or 256 color (or gray) mode for the best results. For the truly best results, you
should use a machine with the Video Expansion Kit installed to use all 256 colors. GrayView converts ThunderScan™
documents to true 32 gray shades and this is not possible if only 16 grays are available.

NOTE: Interface aspects of GrayView are subject to change; it is still in flux. In particular, | made the
icons myself and I'm no artist so they'll have to be fixed. Also, the Tools menu is provided as a rudimentary
Help service; it will not be in the final version.

Notes in this file written in this smaller font contain supplemental information that is not necessarily important. It

may be of a technical nature for advanced users.

Menus
Apple Menu:

The About box contains information about the available memory. Generally speaking, available memory should
be at least twice the size of the file on disk to open it. If the file contains 200K, you'll need at least 400K available to
open it. There are additional memory demands, however, because of overhead. The program will inform the user if
memory runs low.

Desk accessories are fully supported, but you will have better memory management if you try not to open any
new documents while a desk accessory is active. It's not imperative, but it's something to keep in mind if memory is

tight.
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File Menu:

The "Open" item allows you to open three types of files: a document created with GrayView, a file of type PICT
(that is one created by MacDraw or Cricket Draw or a variety of other programs that support this standard), a MacPaint
file, a ThunderScan™ SCAN file, or a TIFF file. MacPaint files are opened using the current depth of the graphics
device so while they start out B/W, you can color them however you like.

If you choose to open a SCAN or TIFF file, a window will be displayed and the file will be converted to gray
scales immediately; you can watch the process. This conversion is quick but not instantaneous, therefore you have
access to desk accessories while the conversion is going on. You can also move and resize windows, but you can't use
any of the paint tools (see below). If you're running under MultiFinder, you can place GrayView in the background and
the conversion will continue unabated. The conversion process can be stopped at any time by hitting command-
(period), or the ESC key.

GrayView can look at any PICT resource. If you hold down the option key while choosing Open, GrayView will
display ALL the files on disk and you can choose one in which GrayView will search for a PICT resource with ID = 0. If it
finds one, it will display it; if not, it will tell you (please don't try to open the System file). PICTs with ID=0 are special on
a Mac Il because those files can be StartUpScreens at boot time by naming it "StartUpScreen™ and placing in the
System Folder.

The "Close" item will close any active window or desk accessory, asking you to save changes if necessary.

The "Save" and "Save as" items allow the user to specify the file to be saved as a standard GrayView file (which
can be used as a StartUpScreen and is the default) or as MacDraw PICT type file. The "Save Selection" item allows the
user to save a portion of the file currently selected with the marquee or lasso.

The "Save as TIFF file" and "Save selection as TIFF file" allow the user to save the current window or a portion
of it as a TIFF file for exporting to applications which read this standard. For instance, a picture can be saved as a TIFF
file and printed on the LaserWriter using PageMaker 2.0. It is saved with the same depth as the window; if the window
was opened with 256 colors active, the TIFF file will contain 256 gray shades. If the window was opened with only 16

colors, the TIFF file will only have 16 gray shades.



Colors in the current window are converted to grays using the same formula the Mac uses to display color
images on B/W monitors. So if you have some color in the picture you can see what the TIFF output will look like by
setting the Control Panel Monitor tool to "Grays" temporarily.

"Revert" will open the last saved copy (if one exists) of the current window.

"Quit" allows the user to leave the program.

Edit Menu:

"Undo" is fully supported by GrayView. You can use it to undo and redo any paint action or image manipulation
(described below). NOTE: Because of MacPaint we've all become used to the upper left key meaning Undo, so the Esc
key (for the regular Apple keyboard) and the " key (for the Extended Apple keyboard) are synonymous with the Undo
menu item, as is its command key equivalent command-Z.

"Cut" is not supported by GrayView yet.

"Copy" will copy a selected portion of the file, using the marquee or lasso, to the clipboard.

"Paste" will take any picture data currently on the clipboard and paste it into a new window.

"Clear" is not supported by GrayView yet.

The rest of the Edit menu consists of commands for manipulating the appearance of the current image. They will
all work with color pictures but the results are not always as you'd expect; they are designed for gray scale images.

Play around, though; you can always Undo later.

The "Tint" item is used to tint any selected portion of the image with the currently selected color or gray on the
gray palette (see below). This process substitutes the color in place of the image wherever the image is darker than the
color. Making the color darker (by double clicking on it and using the Color Picker...see below) will cause less of the

image to be tinted. This is easily seen by experimentation. If no portion is selected, Tint is applied to the whole image.



Here's what Tint does (technical discussion follows): colors are specified on the Mac Il by what amount of red, green, and
blue they are composed of. These amounts are indicated by numbers between 0 and 65535. A totally red red would have red =
65535, green = blue = 0. White is specified by red = green = blue = 65535. Black is specified by red = green = blue = 0. All grays
are special because they all have the same red, green, and blue components, i.e. red = green = blue.

When you ask to Tint with the currently selected color, the Mac looks at each pixel in the image and compares the red, green,
and blue components of that pixel with the same components of the current color. Then it replaces each component in the pixel with
the greater of the two values. For instance, suppose the currently selected color is red = 50000, green = 5000, blue = 14000 (this is
arich red shade). If you try to Tint a gray pixel with values red = green = blue = 12000 (fairly dark), it will be replaced with a pixel with
values red = 50000, green = 12000, blue = 14000 (still basically red). A gray pixel with values red = green = blue = 55000 (very light)
would not be affected at all by tinting with this color, however. What this means is that Tinting basically changes the darker areas of a
picture so that you can still see what the picture is supposed to be. That's very useful and much better than Filling.

If you Tint a region and find that it has changed too much, you can Undo it and easily change the color. For instance,
suppose we are still using the above currently selected red color. As we've seen, most of the document will be made red since we
assume that not all of the document is so light. Double click on the current color in the color palette to bring up the Apple Color
Picker dialog box. You can see the red, green, and blue components of the color in this window. Use the scroll bar on the right to
make the red darker. This will decrease all the components' values. Say you change the color to red = 20000, green = 500, blue =
3000. Click "OK" and return to the document.

Now select Tint again and only rather dark portions of the picture will be changed, those grays whose components are less

than 20000. Using this you can colorize the picture easily.



The "Blur" item will soften the focus on any selected area, making it look like it's under water. This is useful for
reducing the depth of field of an image, or blurring sharp borders between objects. Note that this is a rather slow
process and may seem to take a little while if the selected area is large. The spinning hands on the watch cursor will let
you know that something really is happening. If no area is selected, Blur is applied to the whole image.

The Blur operation is currently slow but will be dramatically sped up for the release product.

The "Invert" item is used to invert any selected portion of the image. If no portion is selected it is applied to the
whole image.

The "Fill" item is used to fill any selected portion of the image with the currently selected color or gray on the gray
palette (see below). If no portion is selected it is applied to the whole image.

Sometimes a scanned image has imperfections, especially random noise in darker areas. This was particularly
true of ThunderScan™ 3.2 pictures. The "Filter Pixels" item will attempt to remove such dirt from any selected portion of
the image. This is generally desirable, but sometimes it will Filter the wrong things, perhaps removing the sparkle from
someone's eye. Fear not, however, for it is undoable, like everything in GrayView. If no area is selected it is applied to
the whole image.

The Blur operation is currently slow but will be dramatically sped up for the release product.

The Blur and Filter Pixel operations are not instantaneous, but you can see the progress in the window. If you
decide you don't want to wait for the process to finish, click the mouse and it will stop where it is.

The "Reset Gray Palette" item will reset the gray scale palette on the left portion of the screen to its default
setting (see below).

The "Preferences" item brings up a dialog box allowing you to make certain choices. The "default FatBits level"

and "color matching sensitivity" will be discussed below.



Certain pictures need special colors or grays available to be displayed properly, but they might not necessarily be
available to GrayView. For instance, GrayView uses 64 levels of gray to display digitized images, but if you try to open
a color digitized picture those 64 grays will get in the way of more useful colors, such as light skin tones. If you turn on
the "Use documents native colors" option in the Preferences box, GrayView will look inside any GrayView or MacDraw
PICT document, or any picture pasted from the clipboard, and search for the colors that will make that picture look best.
These will be made available before putting up the window with that picture. Thus specialized pictures can be shown
much more faithfully. This option is only partially operational now. You can set it and open a picture to see its effect, but
most paint-like operations don't really work yet. The biggest problem comes from having two or more windows open at
one time with the "Use native colors" option on. It's still fun play with even now.

The Preferences box also has a "Use 'best colors' in 16 colors" option which is not at all operational yet. It will
allow users without the Video Expansion Kit (and thus limited to 256 colors) to view digitized pictures better, even those

that require more than 16 grays. More on this later.

Tools Menu:
This merely makes the selected tool the current tool. It is useful if the tools palette is currently covered by a

window, and the menu names remind you what each tool is for.

Windows Menu:

The first portion of this menu contains the names of the open windows. Selecting a non-active window will make
it the active one. The second part of the menu is for Zooming in and out of a document. This allows you to look at
images at magnifications of 1X,2X,4X, and 8X. Selecting "Zoom In" moves you to the next magnification level, whereas
"Zoom Out" decreases one level. At any magnification other than 1X, the current window is split in half, with the
magnified portion to the right and the normal portion to the left. Clicking on the normal portion will cause the area
surrounding the pointer to be displayed at the right. You can click on the normal portion and move the mouse around

(while holding down the button) to scroll in any direction.



You can use the Preferences box to specify a "default FatBits level," either 2X, 4X, or 8X. Then if you double
click on the Pencil tool (see below) you will go to this FatBits level if you're not already there. If you are at the FatBits
level, you'll be returned to normal 1X level. Also, command-clicking with the Pencil or the Paintbrush on an open
window, will cause that area (where you clicked) to be displayed in FatBits if it is not already, or returned to normal 1X
mode if you're already at FatBits.

Any of the palette tools described below can be used on the magnified portion, as well as any of the effects from
the Edit menu.

"Overview" displays a version of the active window so that the image fits inside a alert box on the screen. A
frame is also displayed to indicate what portion is currently visible. You can you use the mouse to position the frame to
view another portion of the document. This is useful for looking at the whole picture if it is larger than the screen.

You can also get the Overview by double-clicking on the Hand tool on the tools palette.

"Clone Document" opens a window with another copy of the active window. The user is given the chance to
specify scaling factors for the new version, so you can make it larger or smaller if you wish. You can clone a specific

selection in the active window by selecting it with the marquee tool and choosing "Clone Selection."

The Gray and Tool Palettes

The palette on the left side of the screen initially shows the 32 grays used for ThunderScan conversion. If you
are not in 8-bit mode, all available grays are shown, with the remaining colors shown as white. At the top of the palette

is the currently selected color,
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used for drawing, paint, filling, and tinting. Clicking on any of the other colors makes it the current color.

Double clicking on any color (including the currently selected color) will cause a small window to pop up next to
the mouse with all possible colors available. The color (or gray) you double-clicked on will be highlighted on the
window. (After this window is activated you can cancel, and stay with the original color, by clicking anywhere outside the
window.) Use the mouse to select a new color and let go of the button. This new color will replace the one you double-
clicked on.

Sometimes, however, you may want to use the standard Apple Color Picker package to choose your color. For
instance, if you want exact control of the R-G-B components of the color, the Color Picker is wonderful. You can use the
Color Picker rather than the window method described above by double clicking on the palette color while holding down
the option key.

The Reset Gray Palette menu item will reset the colors to their default grays.

Below the gray palette is the tool palette, consisting of the marquee, the lasso, the hand, the pencil, the eraser,
the paint brush, the airbrush-lighter and airbrush-darker tools, the Blur tool, and the Color Mapping tool. The currently
selected tool is highlighted. Clicking on any other tool will make it the current tool. Note: if you attempt to perform any of
the actions under the Edit menu (Tint, Fill, etc.) and NO portion of the document is selected, the program will interpret
that to mean you want the whole document, so the marquee will be made the current tool and the entire picture will be
selected, including any portion not shown in the window.

Also, if the cursor is over the active window and you hold down the option key, the cursor will change to a hand
cursor and you can use it to drag the document around, instead of using the scroll bars.

The marquee and lasso work like their MacPaint cousins. If you are selecting near the edge of a window, the

window will scroll to reveal more of the image (if there is any
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available, that is). Holding down the option key while scrolling an image will activate the fast scrolling mode for
selecting large areas.

When a region has been selected with the marquee or the lasso and you move the pointer over the region, the
pointer changes to the normal arrow. Now you can click on this region and drag it anywhere, just like MacPaint. See
the end of this file for warnings about dragging. If you hold down the shift key a copy of the selected region will be
dragged, otherwise the selected region will be erased to white first.

The pencil is used to draw in the current color. This is nice for touching up scanned documents. The pencil has
two other very important features: first, if you hold down the shift key while clicking in a window with the pencil tool, the
color underneath the pencil will be picked up and made the current color. This color is also displayed on the tool palette
in place of the Pencil tool while the shift key is down. If you continue to hold the mouse down it will draw in this new
color. It's great for easily removing blemishes: suppose a person in your image has a mole on his nose that you want
to remove. The skin tones surrounding the mole will be lighter than the mole itself. Therefore, hold down the shift key
and click on the skin near the mole. This lighter color will be made the current color. Now draw over the mole, and
presto!, no mole. This trick is also good for using the exact color or gray located elsewhere in a document (or in another
document, for that matter).

Secondly, holding down the Control key while clicking in the document indicates that you want to Tint the
document with the pencil rather than draw. Moving the mouse around then will have the same effect as the Tint menu
item.

Hold down the shift key and the Control key and the pencil tool will Tint with the color right underneath where you
initially clicked on the window.

If you double-click on the pencil tool you will be taken to the default FatBits mode if you're not aleady there, and
to normal mode if you are already in FatBits.

The paint tool is identical to the pencil, just using a bigger drawing area instead of a single point. It also uses the

shift trick to pick up colors and the Control key trick to Tint.
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If the pencil or paintbrush is selected, command-clicking on the active window will take you to FatBits, with that
area centered on the FatBits display.

Finally, double-clicking on the paint tool allows you to select a new paintbrush shape.

The eraser tool is similar to the paint tool, but it erases the picture to white, like MacPaint.

The airbrush-lighter tool will lighten pixels underneath it while the mouse is held down. The longer the mouse is
down the lighter things become, so be sure to move the mouse about so as to not "burn” the image. The airbrush-
darker tool darkens pixels, working the same way as the airbrush-lighter tool. The effects of each of these tools can be
very subtle but it is really doing something. Just try leaving the mouse in one place for a few seconds to see this.

You can change the size of the area affected by the airbrush tools by double clicking on the tool in the palette.

The "Blur" tool is used to blur areas with the mouse. Moving it around (with the button down, of course)
constantly applies the same softening algorithm used in the Blur menu item. This way you can selectively soften the
focus on areas, make borders between objects less distinct, or bleed colors or grays together, as if water was applied to
a watercolor painting.

The "Color Mapping" tool can be used to replace all instances of any color (or gray, which is what it is primarily
used for) in the selected region with another. To do this, first use the marquee or the lasso to select some area (if you
don't, the tool assumes you want to remap the whole image). Also, change the current color (at the top of the palette) to
the color you want to map to (i.e., the color you'll be left with after remapping). Then choose the Color Mapping tool, and
click on a pixel in the document which has the color you wish to be remapped. The color underneath the Mapping tool
is displayed in the tool's place on the palette to make it easier to choose which pixel to click on. Once you click, all

instances of the color under the tool which occur in the selected area will be replaced by the currently selected color.
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The Preferences dialog box allows you to specify the "color mapping sensitivity." This is a precentage between
0% and 100%. The idea is to determine how picky the mapping tool is going to be. For 100%, the tool is completely
sensitive and it will only change pixels which have the exact same color as the pixel you clicked on. But you can
change that; if you set the sensitivity to 95%, say, it will change pixels whose color is relatively close to that of the pixel
you clicked on. Exactly how close 95% means the color has to be is hard to say, but the effects are obvious if you
experiment with the color mapping tool and sensitivity. NOTE: a 0% sensitivity means that all colors in picture will be

changed and color mapping tool has the same effect as Fill.

A note is necessary about the pencil, the paint brush, airbrush, and the Blur tools: these tools will generally be
used only on small regions between mouse clicks. If you use the paint tool, for instance, to paint a large sweeping area
and memory is low, the program may decide that the action would not be undoable. In this case, it would beep once
and the action would be undone right then. The correction for this is to paint the same area as a series of smaller
areas, lifting the mouse button periodically. Then each smaller area would be undoable until the mouse was clicked

again. Please do not worry about this unless you are running low on memory. Generally it is not a problem.

Brightnhess and Contrast Controls:

Below the tool palette you can find four arrows, two for each of the "Brightness" and "Contrast" controls. You can
use these by selecting a region of the current window using the marquee or lasso tools, and clicking on the arrows (If
you don't select a region the controls presume you want the effect to take place over the whole document). Clicking on
the up brightness arrow will make the region lighter, clicking on the down brightness arrow makes it darker. The
contrast control works similarly: click on the up arrow to increase the contrast and the down arrow to decrease the

contrast.
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If you continue to hold the mouse button down on this control you can continue to change the picture. By holding
the mouse down on the up brightness arrow, for example, you will see the selection get lighter and lighter until it is
eventually white.

Each of these controls are designed to work with B/W pictures. They may or may not work with color, depending
on the nature of the color picture.

There's a special trick for the Brightness controls. By holding down the option key while clicking, you can invoke
the "Wrap Around" mode. For instance, if you option click on the up brightness arrow, the picture will get lighter and
lighter. But any pixels that become totally white will "wrap around" to black. If you option click on the down brightness

arrow blacks will wrap around to white. This is not very natural but it does make for some nice effects.

Known problems

. Doesn't yet read ThunderScan™ TIFF files.

. Only reads 4 and 8 bit TIFF files (for now).

. Only reads TIFF files while 256 colors are available (for now).

. Save Selection as TIFF file will often mess up the screen by drawing the marquee askew.

. Needs to learn how to request temporary memory from

MultiFinder.

. When memory is short a window will sometimes open blank.

. Doesn't save 4 bit TIFF files properly, that is when using the 16 color setting in the Control Panel.

. Dragging: Dragging functions are still in the early stages and there is work yet to be done. First, dragging

doesn't work at all in 2X, 4X, or 8X modes. Second, if you drag a region and then let go of the mouse it will remain
selected, which is correct. But if you try to drag it again it will erase what was underneath it. Also, the Paste function
must be modified so that the picture on the Clipboard is pasted into the active window and not a new window (which will
be preserved as an option). Finally, when a dragged region is erased it is replaced by white. The user will be able to

choose the color that should replace the selected region (it will be called the background color).



